The life cycle of Medical Imaging Data

Sonia Pujol, Ph.D.
Instructor of Radiology
Surgical Planning Laboratory
Harvard Medical School
http://www.spl.harvard.edu/
The Life Cycle of Medical Imaging Data

Acquisition  Storage  Display  Analysis
What is an image?
What is an image?

2D array of pixels
The Life Cycle of Medical Imaging Data

Acquisition

Storage

Display

Analysis

Image: NIH

Image by MIT OpenCourseWare.
Imaging Modalities

- X-Ray Fluoroscopy
  - Image: National Cancer Institute

- Computed Tomography
  - Image: NIH

- Magnetic Resonance Imaging
  - Image: NIH

- Ultrasound Imaging
  - Image: NASA
The result of the acquisition is a 3D Volume of data related to the patient.

The 3D volume is sampled on a 3D grid in the coordinate system (I,J,K).
The Life Cycle of Medical Imaging Data

Acquisition  

Storage  

Display  

Analysis

Image: NIH

Image by MIT OpenCourseWare.
Data Representation
Data Representation

- Patient information
- Acquisition information
- Image Information

The Life Cycle of Medical Imaging Data, Sonia Pujol, Ph.D.
HST.583
Data Representation

0002,0000,File Meta Elements Group Len=148
0002,0001,File Meta Info Version=256
0002,0002,Media Storage SOP Class UID=1.2.840.10008.5.1.4.1.1.4.
...
0008,0060,Modality=MR
0008,0070,Manufacturer=GE MEDICAL SYSTEMS
0008,0080,Institution Name=1852796513
0008,0081,City Name=1852796513
0008,0090,Referring Physician's Name=1852796513
0008,0092,?,=1852796513
0008,0201,?,=-0500
0008,1010,Station Name=1852796513
0010,0010,Patient's Name=anon
0010,0020,Patient ID=anon
0010,0030,Patient Date of Birth=00000000
0010,0032,Patient Birth Time=000000
0010,0040,Patient Sex=O
0010,1010,Patient Age=000Y
........
0028,0010,Rows=256
0028,0011,Columns=256
0028,0030,Pixel Spacing=0.937500 0.937500
0028,0100,Bits Allocated=16
0028,0101,Bits Stored=16
0028,0102,High Bit=15
0028,0103,Pixel Representation=1
........
7FE0,0010,Pixel Data=131072
File Formats
Vendor Specific Radiological File Format

• GE Advantage: GE format for CT and MRI
• GE Advance PET: GE Advance PET scanner format
• GE StarcamOlder: GE nuclear medicine image file format
• Siemens MAGVIS: Siemens Magnetom Vision MRI format
• SMISA: small-bore MRI Image file format (Bruker)
• ....
Standard Radiological File Format

American College of Radiologists (ACR) & National Electrical Manufacturers Association (NEMA)
- ACR/NEMA 1.0 (1985)
- ACR/NEMA 2.0 (1988)

Digital Imaging and Communications in Medicine
- DICOM 3.0 (1993)
Example 1: DICOM 3.0
Example 1: DICOM 3.0

**Physician and Study information**

- Modality: MR
- Manufacturer: GE MEDICAL SYSTEMS
- Institution Name: 1852796513
- City Name: 1852796513
- Referring Physician's Name: 1852796513
- Referring Physician's Name: 1852796513
- Station Name: anon
- Study Description: anon
- Series Description: anon
- Institutional Dept. Name: 1852796513
- Performing Physician's Name: 1852796513
- Name Phys(s) Read Study: 1852796513
- Operator's Name: anon
- Admitting Diagnosis Description: 1852796513
- Manufacturer's Model Name: GENESIS.SIGNA

**Example of DICOM header content**

- Rows: 256
- Columns: 256
- Pixel Spacing: 0.937500 0.937500
- Bits Allocated: 16
- Bits Stored: 16
- High Bit: 15
- Pixel Representation: 1

**Pixel Data value:** 131072
Example 1: DICOM 3.0

0002,0000,File Meta Elements Group Len=148
0002,0001,File Meta Info Version=256
0002,0002,Media Storage SOP Class UID=1.2.840.10008.5.1.4.1.1.4.
0002,0003,Media Storage SOP Inst UID=0.0.0.0.
0002,0010,Transfer Syntax UID=1.2.840.10008.1.2.1.
...
0008,0060,Modality=MR
0008,0070,Manufacturer=GE MEDICAL SYSTEMS
0008,0080,Institution Name=1852796513
0008,0081,City Name=1852796513
0008,0090,Referring Physician’s Name=1852796513
0008,0092,=?=1852796513
0008,0201,=?=0500
0008,1010,Station Name=1852796513
0008,1030,Study Description=anon
0008,103E,Series Description=anon
0008,1040,Institutional Dept. Name=1852796513
0008,1050,Performing Physician’s Name=1852796513
0008,1060,Name Phys(s) Read Study=1852796513
0008,1070,Operator’s Name=anon
0008,1080,Admitting Diagnosis Description=1852796513
0008,1090,Manufacturer’s Model Name=GENESIS SIGNA
0010,0010,Patient’s Name=anon
0010,0020,Patient ID=anon
0010,0030,Patient Date of Birth=00000000
0010,0032,Patient Birth Time=000000
0010,0040,Patient Sex=O
0010,1010,Patient Age=000Y
......
0028,0010,Rows=256
0028,0011,Columns=256
0028,0030,Pixel Spacing=0.937500 0.937500
0028,0100,Bits Allocated=16
0028,0101,Bits Stored=16
0028,0102,High Bit=15
0028,0103,Pixel Representation=1
......
7FE0,0010,Pixel Data=131072
Example 1: DICOM 3.0

Image information

Example of DICOM header content

0002,0000,File Meta Elements Group Len=148
0002,0001,File Meta Info Version=256
0002,0002,Media Storage SOP Class UID=1.2.840.10008.5.1.4.1.1.4.
0002,0003,Media Storage SOP Inst UID=0.0.0.0.
0002,0010,Transfer Syntax UID=1.2.840.10008.1.2.1.

...

0008,0060,Modality=MR
0008,0070,Manufacturer=GE MEDICAL SYSTEMS
0008,0080,Institution Name=1852796513
0008,0081,City Name=1852796513
0008,0090,Referring Physician's Name=1852796513
0008,0092,=1852796513
0008,0201,=0500
0008,1010,Station Name=1852796513
0008,1030,Study Description=anon
0008,103E,Series Description=anon
0008,1040,Institutional Dept. Name=1852796513
0008,1050,Performing Physician's Name=1852796513
0008,1060,Name Phys(s) Read Study=1852796513
0008,1070,Operator's Name=anon
0008,1080,Admitting Diagnosis Description=1852796513
0008,1090,Unknown=anon
0010,0020,Patient ID=anon
0010,0030,Patient Date of Birth=00000000
0010,0032,Patient Birth Time=00000000
0010,0040,Patient Sex=O
0010,0042,Patient Age=000Y
0028,0010,Rows=256
0028,0011,Columns=256
0028,0030,Pixel Spacing=0.937500 0.937500
0028,0100,Bits Allocated=16
0028,0101,Bits Stored=16
0028,0102,High Bit=15
0028,0103,Pixel Representation=1

......

7FE0,0010,Pixel Data=131072
Example 1: DICOM 3.0

Example of DICOM header content

The data

0002,0000, File Meta Elements Group Len=148
0002,0001, File Meta Info Version=256
0002,0002, Media Storage SOP Class UID=1.2.840.10008.5.1.4.1.1.4.
0002,0003, Media Storage SOP Inst UID=0.0.0.0.
0002,0010, Transfer Syntax UID=1.2.840.10008.1.2.1.
...
0008,0060, Modality=MR
0008,0070, Manufacturer=GE MEDICAL SYSTEMS
0008,0080, Institution Name=1852796513
0008,0081, City Name=1852796513
0008,0090, Referring Physician's Name=1852796513
0008,0092, =1852796513
0008,0201, =0500
0008,1010, Station Name=1852796513
0008,1030, Study Description=anon
0008,103E, Series Description=anon
0008,1040, Institutional Dept. Name=1852796513
0008,1050, Performing Physician's Name=1852796513
0008,1060, Name Phys(s) Read Study=1852796513
0008,1070, Operator's Name=anon
0008,1080, Admitting Diagnosis Description=1852796513
0008,1090, Manufacturer's Model Name=GENESIS.SIGNA ....
0010,0010, Patient's Name=anon
0010,0020, Patient ID=anon
0010,0030, Patient Date of Birth=00000000
0010,0032, Patient Birth Time=000000
0010,0040, Patient Sex=O
0010,1010, Patient Age=000Y
........
0028,0010, Rows=256
0028,0011, Columns=256
0028,0030, Pixel Spacing=
0028,0100, Bits Allocated=16
0028,0101, Bits Stored=16
0028,0102, High Bit=15
0028,0103, Pixel Representation=

7FE0.0010, Pixel Data=131072
Image Processing File Format

• Analyze 7.5 Mayo Clinic
• Minc (Medical Image NetCDF )
Montreal Neurological Institute
• SPM (Statistical Parametric Mapping)
• NifTI (Neuroimaging Informatics Initiative)
Example 2: ANALYZE 7.5

Raw Data

Header

Image.hdr

Image.img
Example 2: ANALYZE 7.5

Image information
Pixel Data

<table>
<thead>
<tr>
<th>header</th>
<th>data</th>
</tr>
</thead>
<tbody>
<tr>
<td>0002,0000,File Meta Elements Group Len=148</td>
<td>0028,0010,Pixel Data=131072</td>
</tr>
<tr>
<td>0002,0001,File Meta Info Version=256</td>
<td>0028,0011,Columnns=256</td>
</tr>
<tr>
<td>0002,0002,Media Storage SOP Class</td>
<td>0028,0030,Pixel Spacing=0.937500 0.937500</td>
</tr>
<tr>
<td>UID=1.2.840.10008.5.1.4.1.1.4.</td>
<td>0028,0100,Bits Allocated=16</td>
</tr>
<tr>
<td>…</td>
<td>0028,0101,Bits Stored=16</td>
</tr>
<tr>
<td>0008,0060,Modality=MR</td>
<td>0028,0102,High Bit=15</td>
</tr>
<tr>
<td>0008,0070,Manufacturer=GE MEDICAL SYSTEMS</td>
<td>0028,0103,Pixel Representation=1</td>
</tr>
<tr>
<td>0008,0080,Institution Name=1852796513</td>
<td>…</td>
</tr>
<tr>
<td>0008,0081,City Name=1852796513</td>
<td>…</td>
</tr>
<tr>
<td>0008,0090,Referring Physician's Name=1852796513</td>
<td>…</td>
</tr>
<tr>
<td>0008,0092,=?=1852796513</td>
<td>…</td>
</tr>
<tr>
<td>0008,0201,=?=-0500</td>
<td>…</td>
</tr>
<tr>
<td>0008,1010,Station Name=1852796513</td>
<td>…</td>
</tr>
<tr>
<td>0010,0010,Patient's Name=anon</td>
<td>…</td>
</tr>
<tr>
<td>0010,0020,Patient ID=anon</td>
<td>…</td>
</tr>
<tr>
<td>0010,0030,Patient Date of Birth=00000000</td>
<td>…</td>
</tr>
<tr>
<td>0010,0032,Patient Birth Time=000000</td>
<td>…</td>
</tr>
<tr>
<td>0010,0040,Patient Sex=O</td>
<td>…</td>
</tr>
<tr>
<td>0010,0042,Patient Age=000Y</td>
<td>…</td>
</tr>
<tr>
<td>…</td>
<td>…</td>
</tr>
<tr>
<td>0028,0010,Rows=256</td>
<td>…</td>
</tr>
<tr>
<td>0028,0011,Columns=256</td>
<td>…</td>
</tr>
<tr>
<td>0028,0030,Pixel Spacing=0.937500 0.937500</td>
<td>…</td>
</tr>
</tbody>
</table>
Pixel Data

8 bits/pixel → 256 grey levels
16 bits/pixel → 65,356 grey levels

I min → I max
Pixel Encoding

1 pixel = 2 bytes

Bits allocated = 16
Bits stored = 12
High Bit = 11
2 types of algorithms

The **lossless compression** techniques allow the exact original data to be reconstructed from the compressed data.

Ex: JPEG-LS

The **lossy compression** techniques deliberately discard information that is not diagnostically important.

Ex: JPEG
The Life Cycle of Medical Imaging Data

Acquisition  Storage  Display  Analysis

Image: NIH

Image by MIT OpenCourseWare.
Data Representation

The 3D volume is sampled on a 3D grid in the coordinate system (I,J,K).
Image Dimensions

Standard Image Sizes
256 x 256
512 x 512
1024 x 1024
Pixel Dimensions

The pixel size is the dimension in millimeters of the pixels.
The slice thickness corresponds to the section of the patient being scanned.
The slice spacing is the distance between consecutive slices.
Visualization

X-Ray Fluoroscopy

Computed Tomography

Magnetic Resonance Imaging

Ultrasound Imaging
3D Slicer platform

Launch the executable 
`slicer2-linux-x86`
located in the directory 
`slicer2.6-opt-linux-x86-2006-09-08/`
3DSlicer Platform

Menu

Viewer

Tk window
Click **Add Volume** in the left panel.
Image Header

The panel Props of the module Volumes appears.

Left-Click on Properties Basics, and select the format DICOM.
The DICOM reader panel appears.

Click on **Select DICOM Volume**
Select the sub-directory sampleImage in the directory /MRI-data/dicom/ and click on OK.
Click on **List Headers** to display the content of the header of the first image.
The list of Dicom tags of the header appears in the lower part in the lower part of the window.
Image Header

Scroll up and down to display the values of the different tags

The Life Cycle of Medical Imaging Data, Sonia Pujol, Ph.D.
HST.583
Image Header

Click on OK to close the **Dicom Header Window**
Anatomical Planes

Select File→OpenScene in the Main menu

Select the scene *AnatomicalPlanes.xml* in the directory *MRI-data*/*
Anatomical Planes

The 3DViewer displays a model of the head.

The 2DViewer displays the three anatomical planes.
2D Viewer
Click on the button V (Visualization) to display the axial slice in the 3DViewer.
Axial View

Slicer displays the axial slice in the 3DViewer

The Life Cycle of Medical Imaging Data, Sonia Pujol, Ph.D.
HST.583
Axial View

Use the slider to scroll inside the MRI volume
Sagittal View

Deselect the axial view and click on V to display the sagittal slice in the 3DViewer.
Coronal View

Deselect the sagittal view and click on V to display the coronal slice in the 3DViewer.
Coronal View

Move the mouse over the coronal image in the 2DViewer.
Image Intensity

The value of the pixel intensity of the volume loaded in Background (Bg) is displayed on the image.
RAS coordinates

The coordinates of the pixel pointed by the mouse appear in the left corner of the image.
Anatomical Planes

3D visualization
Position the mouse on the 3D model inside the Viewer
Left-click and move the mouse to the left

The model moves to the left
Anatomical Planes

3D visualization
Position the mouse on the 3D model inside the Viewer
Left-click and move the mouse to the right

The model moves to the right
Space Directions

Superior

Posterior

Right

Inferior

Left

Anterior

The Life Cycle of Medical Imaging Data, Sonia Pujol, Ph.D.
HST.583
Voxel ordering

Problem: Which directions are the rows and slices?
Space Orientation

Indicate the left and right side of the patient in the images
Space Orientation
Example

fMRI study:
• Finger-tapping task
• Alternating left-hand / right-hand
• Contralateral side vs Ipsilateral side

→ Knowledge of left/right side of the patient in the image is crucial for the interpretation of the results.
Axes for Spatial Coordinates

RAS: Right-Anterior-Superior

The index i in the file increases from the Left to the \textbf{Right} side of the Patient.

The index j in the file increases from Posterior to \textbf{Anterior}.

The index k in the file increases from \textbf{Inferior} to Superior.
Axes for Spatial Coordinates

LPS: Left-Posterior-Superior

The index $i$ in the file increases from the Right to the Left side of the Patient.

The index $j$ in the file increases from Anterior to Posterior.

The index $k$ in the file increases from Inferior to Superior.
Real Clinical Situation

• …is not straightforward: the image volume is not aligned to some exact orthogonal directions
Real Clinical Situation

- ...is not straightforward: the image volume is not aligned to some exact orthogonal directions
- However, the acquisition parameters determine which set of axes the voxel indices correspond to most closely.
Real Clinical Situation

• ...is not straightforward: the image volume is not aligned to some exact orthogonal directions

• However, the acquisition parameters determine which set of axes the voxel indices correspond to most closely.

• Spatial transforms are used to align a volume to a specific space.
Reference Frames

$R_{patient}$

$R_{acquisition}$

$R_{image}$
Registration

Registration is the process of transforming these three different spaces into a common reference frame.
Patient \rightarrow \text{Image Transform}

\begin{align*}
\text{Patient Space} & \quad \text{Image Space} \\
M(x,y,z) & \quad M(a,b,c)
\end{align*}

\begin{align*}
T_{\text{patient} \rightarrow \text{image}}
\end{align*}
Patient → Image Transform

Patient Space
XYZ

O (X₀, Y₀, Z₀)
Homogenous Coordinate Transform matrix

\[ M(x, y, z, 1) = T_{\text{image } \rightarrow \text{patient}} \ast M(a, b, c, 1) \]

\[
T_{\text{Image } \rightarrow \text{Patient}} = \begin{pmatrix}
    m_{01} & m_{01} & m_{02} & Tx \\
    m_{10} & m_{11} & m_{12} & Ty \\
    m_{20} & m_{21} & m_{22} & Tz \\
    0 & 0 & 0 & 1
\end{pmatrix}
\]

Spatial transformation of homogenous voxel coordinates between the image space and the patient space
Homogenous Coordinate Transform matrix

\[
\begin{align*}
M(x, y, z, 1) &= T_{\text{image} \rightarrow \text{patient}} \ast M(a, b, c, 1) \\
T_{\text{image} \rightarrow \text{patient}} &= \begin{pmatrix}
m_{01} & m_{01} & m_{02} & Tx \\
m_{10} & m_{11} & m_{12} & Ty \\
m_{20} & m_{21} & m_{22} & Tz \\
0 & 0 & 0 & 1
\end{pmatrix}
\end{align*}
\]

Coordinate of the first voxel in patient space

The Life Cycle of Medical Imaging Data, Sonia Pujol, Ph.D.
HST.583
Homogeneous Coordinate Transform matrix

\[ M(x, y, z, 1) = T_{image \rightarrow patient} \cdot M(a, b, c, 1) \]

\[
T_{image \rightarrow patient} = \begin{pmatrix}
  m_{01} & m_{01} & m_{02} & Tx \\
  m_{10} & m_{11} & m_{12} & Ty \\
  m_{20} & m_{21} & m_{22} & Tz \\
  0 & 0 & 0 & 1
\end{pmatrix}
\]

Rotation matrix
Data Fusion

Registering all the images in a common reference frame allows a quantitative analysis of multi-modality datasets.
Data Fusion

Example: Registration of high-resolution anatomical and functional datasets to improve localization of findings for fMRI analysis
Homogenous Coordinate Transform matrices

\[ M(a', b', c', 1) = T_{\text{patient} \rightarrow \text{image2}} \times T_{\text{image1} \rightarrow \text{patient}} \times M(a, b, c, 1) \]
Data Fusion Example

fMRI activation map superimposed on the anatomical images
The Life Cycle of Medical Imaging Data
fMRI Analysis Workflow

Data Loading
Paradigm Description
Signal Modelling
Activation Detection
Statistical Analysis
fMRI Analysis Workflow

Data Loading

Paradigm Description

Signal Modeling

Activation Detection

Statistical Analysis

The Life Cycle of Medical Imaging Data, Sonia Pujol, Ph.D.
HST.583
Data description

Structural (MPRAGE): ANALYZE format
135 slices

Normalized to MNI

Pre-processed Functional (EPI): NIFTI format
68 slices
Loading the structural dataset

Click on **File → Close Scene** to close the scene containing the first MRI-dataset.

Click on **Add Volume** in the main menu
Loading the structural dataset

Select the reader **Generic Reader** in the Props Panel of the module **Volumes**.

Click on Browse, select the file **Anatomical3T.hdr** in the directory

```
/fMRI-data1/structural/
```

Click on **Apply** to load the dataset.
Loading the structural dataset
Loading the fMRI dataset

Select **Modules** in the main menu
Select **Application → fMRIEngine**
fMRI Data pre-processing (SPM)

- Realignment
- Motion Correction
- Normalization to MNI
- Smoothing
Load Image Sequence

Pick **Sequence → Load** tab

Click on Browse and select the file **functional01.hdr** in the directory

`/fMRI-data1/structural/`

Select **Load Multiple Files**

Enter the sequence name **testFunctional** and click on **Apply.**
Load Image Sequence

Slicer displays the load status of the 30 functional volumes.
Load Image Sequence

The functional volumes appear in the Viewer.
Set Image Display

Click on the module **Volumes**, and select the panel **Display**

Adjust **Win** and **Lev** to get best display of image data
Set Image Display

Click on the letter I (Inferior) in the control window to display the Inferior view.
Set Image Display

Click on the **V** button to display the axial slice in the Viewer.
Set Image Display

Adjust the low threshold $Lo$ to mask out background
Set Image Display

The display settings apply to currently viewed image in the sequence only
Set Sequence Display

Click on **fMRIEngine**, select the panel **Sequence**, and pick the tab **Select**

Click **Set Window/Level/Thresholds** to apply to all volumes in the sequence

Visually inspect sequence using the **Volume index** to check for intensities aberrations
Inspect Image Display

Slicer displays the volumes of the sequence.
Select Image Sequence

Specify the **number of runs = 1**, select the sequence **testFunctional**

Click **Add** to assign sequence to run 1
Select Image Sequence

Slicer assigns the sequence to run 1
fMRI Analysis Workflow

Data Loading

Paradigm Description

Signal Modelling

Activation Detection

Statistical Analysis
Paradigm description

• Finger sequencing fMRI task to elicit activation in the hand regions of the primary sensory motor cortex

• Block design motor paradigm

• Subject touches thumb to fingers sequentially within block (thumb touches first through fourth finger)

• Subject alternates left and right hand
Paradigm design

Three cycles
rest | right hand | left hand

Cycle 1
rest | right | left

Cycle 2
rest | right | left

Cycle 3
rest | right | left

TRs
Paradigm timing parameters

- Repetition Time TR = 2s
- Durations: 10 TRs in all epochs
- Onsets (in TRs):

  Rest: 0  30  60
  Right: 10  40  70
  Left:  20  50  80
Stimulus schedule

Pick **Set Up** Tab in the fMRIEngine and choose the **Linear Modeling** detector
Linear Modeling

The **General Linear Modeling** is a class of statistical tests assuming that the experimental data are composed of the linear combination of different model factors, along with uncorrelated noise

\[ Y = BX + e \]

- **B** = set of experimental parameters
- **Y** = Observed data
- **X** = Design Matrix
- **e** = noise
Stimulus schedule

Select the design type **Blocked**
Stimulus schedule

Enter the characteristics of the run **TR = 2** and **Start Volume = 0** (ordinal number)
Stimulus schedule

Enter the schedule for the first condition:
Name = right
Onset = 10
Durations = 10

Click on OK to add this condition to the list of defined conditions
Stimulus schedule

Enter the schedule for the second condition:
Name = left
Onset = 20
Durations = 10

Click on OK to add this condition to the list of defined conditions
Stimulus schedule

Scroll down in the **Set-up** panel to see the list of defined conditions
Editing the Stimulus schedule

The list of specified conditions appears in the left panel.
fMRI Analysis Workflow

Data Loading
Paradigm Description
Signal Modelling
Activation Detection
Statistical Analysis
Model a Condition

Select **Specify Modeling**

Click on **Model all conditions identically**
Model a Condition

Select
- Condition: **all**
- Waveform: **BoxCar**
- Convolution: **HRF**
  (Hemodynamic Response Function)
- Derivatives: **none**
Nuisance Signal Modelling

On the subpanel **Nuisance signal modeling**, select

- **Trend model**: Discrete Cosine
- **Cutoff period**: default

Click on **use default cutoff**
Nuisance Signal Modelling

Scroll down in the Set Up panel and click on **add to model**
The list of explanatory variables (EV) appears in the left panel, including the baseline that is automatically added. The strings are Slicer specific representations of the model.
View Design Matrix

Click **View Design** to display the design matrix.
Design Matrix

A window displaying the model design appears.

Move the mouse from left to right over the columns of the matrix to display the characteristics of the modelled conditions.
Design Matrix

v1 = right finger tapping
v2 = left finger tapping
v3 = baseline
v4 = low frequency noise
Design Matrix

Observe the different values of the signal intensity in the matrix.

- **White** → positive signal intensity 1
- **Mid-Grey** → null intensity 0
- **Black** → negative intensity -1
Design Matrix

Modelled Signal $Y = BX + e$

Each column represents the contribution from each condition we might see in a voxel time course.
Design Matrix

Move the mouse up and down to browse the different volumes associated with the time points.
Estimation

Select **Specify Estimation** to estimate B and e at every voxel:

\[ Y = BX + e \]
Estimating model parameters

The Estimation panel appears

Select run1 and click on Fit Model
Estimating model parameters

Slicer shows the progress of model estimation
Specify Contrasts

In the **SetUp** panel, select **Specify** \(\rightarrow\) **Contrasts**
Specify Contrasts

The Panel for the contrasts appears
Specify Contrasts

Choose the contrast type \textit{t-test}

Enter the contrast name \textbf{myContrast}, and the Volume Name \textbf{R-L\_activation}
Contrast Vector

- Encoding of the effect that you want to test
- A contrast component per column in the design matrix (trailing zeros may be omitted)

1 0 0 0 → test for whether there is any effect for the right hand
1 -1 0 0 → statistically contrast the effect for the right and left hand
Specify Contrasts

Select the statistical test **t-test**

Specify the contrast vector **1 -1 0 0** (enter a space between the values)

Click **OK** to add this contrast to a list of defined contrasts
Specify Contrasts

The resulting contrast named **myContrast-R-L_activation** appears in the list of specified contrasts.
Check contrasts & model

Click on **View Design** to display the Design matrix
A window displaying the design matrix and contrast vector appears.

Check that the contrast and model are correct.
fMRI Analysis Workflow

Data Loading  Paradigm Description  Signal Modelling  Activation Detection  Statistical Analysis
Perform activation detection

Click on the tab **Detect** and select the contrast **myContrast-R-L_activation**

Click on **Compute** to compute the statistical map of activation (t-test)
Select the activation volume

1. Click on the **View Tab**
2. Select the resulting activation volume (t-map) `myContrast-R-L_activation`
3. Click on **Select**
Threshold

Click on the **Threshold** Tab
Threshold

Slicer indicates the degree of freedom (DoF): Nvol-1=29

Enter the p-Value 0.001 and hit ENTER
Null hypothesis

• H0: the difference between the right hand condition and left hand condition has no consequence on the fMRI signal.

• If the resulting probability is lower than the experiment’s alpha value (p < 0.001), the null hypothesis can be rejected.
Threshold

Slicer calculates the corresponding threshold $t_{Stat}$

![Slicer interface showing t Stat = 3.7](image)

$t_{Stat} = 3.7$
Activation map

The activation map is superimposed on the fMRI images.
fMRI color palette

Click on the module **Volumes**

Select the panel **Display** and set the Active Volume to be the activation volume

**myContrast-R-L_activationMap**
fMRI color palette

Adjust the **Window** and **Level** of the color palette for the volume `myContrast-R-L_activationMap`
fMRI color palette

- MAX

Negative activation

No statistical significance

+ MAX

Positive activation
Visualize

Left click on Bg in the 2D anatomical viewers to display the volume **anatomical 3T** in background.
Visualize

The activation map is superimposed on the anatomical images.
fMRI Analysis Workflow

- **Loading**
- **Paradigm Description**
- **Signal Modelling**
- **Activation Detection**
- **Statistical Analysis**
Threshold, visualize, inspect

Pick the tab **Plot** and select the **condition = right**

Select the plot option **Timecourse**
Voxel Timecourse

Position the mouse on a pixel located in the activation map in the 2D anatomical views.
Voxel Timecourse

The voxel’s timecourse plotted with the modelled condition for the selected voxel appears.
Voxel Timecourse

The graphs show a good correlation between the observed BOLD signal $Y(t)$ and the model.
Threshold, visualize, inspect

Mouse over labelled area in Slice Window and left click on the pixel $R = 40\; A = 0\; S = 20$, which is low responder in the activation map.
During the **right condition**, the observed signal decreases in the ipsilaterial side and increases on the contralateral side.
Threshold, visualize, inspect

Select **Peristimulus histogram** option and click on the voxel (-40,0,20) in the positive activation region.
Voxel Peristimulus Plot

Slicer displays a plot of the mean time course values of the selected voxel in the positive activation region during different blocks.
Threshold, visualize, inspect

Select **Peristimulus histogram** option and click on the voxel in the negative activation region (40,0,20)
Voxel Peristimulus Plot

Slicer displays a plot of the mean time course values of the selected voxel in the negative activation region during different blocks.
Activation-based region of interest

Select the ROI panel and RegionMap tab
Choose **New Activation**
Threshold, visualize, inspect

Click **Create label map from activation**, and wait while activation “blobs” are labelled.
Threshold, visualize, inspect

The label map is shown in Foreground, and the activation map is shown in Background.
Regions Statistics

Select the subtab **Stats**
Select one or multiple regions in the left hemisphere to include in analysis by clicking in Slice Window.

Select the condition **right.**
Region Statistics

The selected regions appear in green.
Region Statistics

Click **Show stats** to display the statistics for the selected regions.
Region Statistics

A window displays the statistics for the selected region(s)
Region timecourse

Select **Timecourse plot** option and click **Plot time series** for this region.
Region timecourse

A window displays the region timecourse plot.
Region Peristimulus Plot

Select **Peristimulus histogram** and click **Plot time series** for this region.
Region Peristimulus Plot

A window displays the Region Peristimulus Plot
Visualization

Click on **Clear selections** and display the structural image in the background (Bg) and activation map in the foreground (Fg).
Visualization

Fade in the activation volume for a good view of combined data
Conclusion

• Real clinical situations are not straightforward

• Image orientation, encoding and contents are decisive for correct data analysis

• fMRI studies are highly interdisciplinary
The Life Cycle of Medical Imaging Data

Acquisition  Storage  Display  Analysis